
N
iko

n
 C

ap
tu

re 4 Ed
ito

r

1 /15

SB0000(11)
6MSA0000--

En  Notice to Customers Upgrading to Nikon Capture 4.2

In addition to support for the Nikon D2X digital camera, Nikon Capture 4 version 4.2 offers the new features described below.  

Automatic Update
Nikon Capture 4 is equipped with an automatic update function known as Nikon Message Center.  Nikon Message Center checks 
for updates to a variety of Nikon digital products, including Nikon software.  At default settings, Nikon Message Center will auto-
matically check for updates if the computer is connected to the Internet when Nikon Capture 4 starts.  If an update is available, 
the Nikon Message Center window will be displayed.  Click Available Messages to view the updates available for your Nikon 
digital products and software, then click Install to download and install the desired updates.  To personalize your list of Nikon 
digital products or to view a list of the installed software supported under Nikon Message Center, click My Products.

 Mac OS 9

Nikon Message Center is not available in Mac OS 9.

 Notice to Users in Europe and the U. S. A.

To activate Nikon Message Center, users in Europe and the U. S. A. must have an account with their regional Nikon Support Center.  The fi rst time 
a program equipped with the Nikon Message Center auto update feature starts, a license agreement will be displayed.  After reading the agree-
ment, click Accept to accept its terms and display an account activation dialog.
• If you already have an account with your regional Nikon Support Center, enter the supplied user ID and password and the e-mail address you 

used to register.  After confi rming that the computer is connected to the Internet, click Activate Nikon Message Center.  A dialog allowing 
you to opt in or out of Nikon mailings will be displayed.

• If you do not have an account or have forgotten your password, confi rm that the computer is connected to the Internet and click Visit Nikon 
Support Center.  After obtaining the required account information, enter the details in the account activation dialog and click Activate Nikon 
Message Center.  A dialog allowing you to opt in or out of Nikon mailings will be displayed.

 The Opt-in / Opt-out Dialog

The fi rst time Nikon Message Center starts, a dialog allowing you to opt in or out of Nikon mailings will be displayed.  Select the desired options 
and click OK to display the Nikon Message Center window.

 Downloading Updates

An Internet connection is required to download updates.  The user bears all applicable fees charged by the phone company or Internet service 
provider.

 Dial-up Connections

When using a dial-up connection, be aware that the connection is not automatically terminated when download is complete.  Be sure to termi-
nate the connection manually.

 Privacy

Information provided by the user as part of this service will not be given to third parties without the user’s permission.

 Checking for Updates Manually

To check for updates manually, select Check for updates… from the Help menu.
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Quick Tools
The “Auto Contrast” button in the Quick Tools palette is now an “Auto Brightness” button that performs the 
same function as the Auto button in the Photo Effects palette (see page 13).
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Tool palettes
The default tool palettes are shown below.  A Color Balance Palette can be displayed by selecting Show Color Balance Palette 
from the View menu.

Tool palette 1

Tool palette 2

Tool palette 3
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Finding Tools
To display a complete list of the tools available in Nikon Capture 4 Editor, select 
Find Tool from the View menu.  Tools can be opened from the list by selecting 
the tool name and clicking Go to tool.  Click Name to sort tools in ascending or 
descending order by name or Location to sort tools according to the tool palette 
window in which they can be found.  A bright green dot next to the tool name 
indicates that it has been modifi ed from its original settings.

 “Undo” and “Redo”
The Undo and Redo options in the Edit menu are used to undo and redo the effects of the last operation.  The number of consecutive opera-
tions that can be undone is limited only by the amount of memory available.  Operations can not be undone after you have closed the active 
window or exited Nikon Capture.
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Multi-Image Window
The Multi-Image window contains the following tool buttons:

When the thumbnail area is closed:

But ton Name Func tion

Back to previous folder Return to the previous folder.

Forward to next folder Open the next folder.

Previous Image Display the previous image in the image area.

Next Image Display the next image in the image area.

When the thumbnail area is open:

But ton Name Func tion

Select Folder
Open the Browse For Folder dialog to select a folder for display in the Multi-Image 
window.

Back to previous folder Return to the previous folder.

Forward to next folder Open the next folder.

Remove selected image(s) Delete the images selected in the thumbnail area.

Match Settings

Apply the settings for the selected image to other images.  After selecting a source 
image, select the target images with the shift key or with the Ctrl (Windows) or 
command (Macintosh) key and then click .  The settings for the fi rst image will 
be applied to the remaining images.  To edit multiple images simultaneously, select 
the images and click .  Changes to tool palette settings after the  is clicked will 
apply to all the selected images.

/ Switch thumbnail list Toggle between single- and multi-line thumbnail displays.

Sort

A menu of sort options will be displayed.  Choose Sort Key to sort images by File 
Name, Date of Recording, Date Modifi ed, File Name and Type, File Type and 
Date of Recording, or File Type and Date Modifi ed (if File Type and Date of 
Recording, or File Type and Date Modifi ed is selected, images will be sorted by 
fi le type in the order NEF, JPEG, and TIFF, with images of the same fi le type sorted 
by date of recording or date of modifi cation).  Choose Sort Order to sort images 
in ascending or descending order.

Change Thumbnail Size
Adjust the size of the thumbnails displayed in the Multi-Image window in fi ve 
steps.

Favorite Folder

To add the current folder to your list of favorites, click this button and select Add 
to Favorites from the menu that appears.  To access your favorites, click the  
button in the toolbar.  To organize or delete favorites, click  and select Organize 
Favorites. 
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Straightening Images
To straighten the image in the active image window by up to 10 °:

1 Select Straighten… from the Rotate sub-menu
The Straighten dialog will be displayed.

2 Straighten the image
Straighten the image using the Draw Level button or by entering the desired rotation in the Rotation text box.

The Draw Level Button

The Rotation Text Box
Choose CW (clockwise) or CCW (counter-clockwise) and enter the degree of rotation in the text box.  The image can be 
rotated up to 10 °.

3 Click OK

 Draw Level

If a message is displayed stating that the reference line is too short, choose a longer reference line.

 Straightening Images

Straightening does not change the dimensions of the image.  Any portions of the image that do not fi t in its original dimensions are trimmed, 
while areas that have been added to the image are fi lled in black.

 Restoring the Unrotated Image

To restore the unrotated image, enter a value of 0 in the Rotation text box.

The image will be rotated 
up to 10 ° to make the refer-
ence line horizontal or verti-
cal.  The degree of rotation 
is displayed in the Rotation 
text box.

Click Draw Level.  The cursor 
changes to .

Choose a line in the image 
that should be either hori-
zontal or vertical and drag 
the  cursor parallel to the 
chosen reference line.
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The Histogram Palette
The histogram palette shows the level distribution for the image in the active window or, if a crop is selected, for the current crop.  
To display or hide the Histogram palette, click the triangle in the Histogram palette title bar.  By default, the Histogram palette is 
in Tool Palette 3.

To select an area of the histogram, drag the mouse over the histogram display.  The pixels with values in the selected range will 
blink in the image window.  Click Clear to cancel the current selection.

Channel
View the histogram for the en-
tire image or selected channels.

Start / End
The range of values selected in 
the histogram display.

Input
The level (brightness) of the 
point under the cursor.
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The Markers Palette
Changes to pictures can be recorded using the Markers palette.  To display or hide the Markers palette, click the triangle in the 
Markers palette title bar.  By default, the Information palette is in Tool Palette 3.  To add a marker:

1 Click Add
After editing a picture, open the markers palette and click Add.

2 Enter a marker name

Enter a marker name and click OK.  The new marker will be added to the markers palette.

Selecting the marker in the markers palette will now restore the picture to the state it was in when the marker was created.  
Preset markers are available for restoring pictures to their original or current state or to the state they were in when last 
saved.

To delete a marker, select it in the markers palette and click Delete.

 Markers

Markers for NEF images are saved with the image and recalled whenever the image is opened in Nikon Capture 4 Editor.  Markers for JPEG and 
TIFF images are lost when the image window is closed.
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Show Focus Area
To show the focus area used when the image in the active window was taken, select Show Focus 
Area from the Image menu.

The focus area is shown by red 
focus brackets.
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Tone Curve Point button

Changes to the Curves Palette
A  (“Set Curve Point”) button has been added to the Curves palette.  To add a point to a curve corresponding to tones in the 
active image, click this button and then click the desired location in the active window.

 Show Focus Area

The focus area will not be displayed if the image was created using a COOLPIX-series camera, a non-CPU lens, or manual focus.

 Color Mode

Color Mode settings apply only to photographs taken with D2-series, D1-series D100, or D70 cameras.  Modes I and Ia, which are adapted to the 
sRGB color space, are suited to portraits that will be printed or used “as is” with little or no mod i fi  ca tion.  Mode II is adapted to the Adobe RGB 
color space.  This color space is capable of expressing a wider gamut of colors than sRGB, making it the pre ferred choice for pictures that will be 
extensively processed or retouched.  Modes III and IIIa, which are adapted to the sRGB color space, are suited to nature or land scape shots that 
will be printed or used “as is” with little or no modifi cation.

Color Mode (Advanced RAW)
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The Master Lightness Channel
Although it affects brightness rather than color, editing luminosity has a similar effect to editing the master curve in the Curves 
palette.

Luminosity curve: Maps luminosity in the original image (input) to the luminosity of the image after editing (output).  Any 
portion of the curve can be edited as described in “Curves” ; steepening the curve increases the difference between light and 
dark areas of the image, increasing contrast.

Histogram: Shows the distribution of pixels of different luminosities in the input.  The horizontal axis corresponds to luminosity 
(in the range 0–255), the vertical axis to the number of pixels.

Output level sliders: Choose the maximum (white point) and minimum (black point) values for output.

Input level sliders: Choose the maximum (white point) and minimum (black point) input levels.

Mid-point slider: Set the mid-point (gamma value).  Moving the mid-point alters the brightness of mid-tones while preserving 
detail in highlights and shadows.

Show Histogram button: Click to view the luminosity distribution for the fi nal image.  Click again to view the input luminosity 
distribution.

Auto Contrast button: Set the maximum and minimum input levels to exclude values for 0.5% of the brightest and darkest 
pixels in the crop.  The percentage of pixels excluded can be adjusted in the Advanced Color tab in the Preferences dialog.

Show Histogram button

Auto Contrast button

Histogram

White-point 
input slider

Mid-point 
slider

Black-point 
input slider

Black-point output 
level slider

White-point output 
level slider

Luminosity curve

Changes to the LCH Editor Palette
The LCH Editor palette now contains the following channels:

The Color Lightness Channel
The Color Lightness channel controls the brightness of colors without affecting chroma or hue.  It can be used, for example, to 
brighten the blue of a dark sky.

Color lightness curve: Maps the brightness of colors in the original image (input) to the brightness of colors after editing 
(output).  Moving a point on the curve upward makes colors in the affected portion of the color range more brighter, while 
moving it downward makes the affected colors darker.

Width slider: Adjust the width of the curve that passes through the selected point, increasing or decreasing the range of colors 
affected by the change.

Intensity: The amount by which the brightness of colors under the selected point will be increased or decreased in the output 
image.

Width slider

Color lightness curve
(vertical axis corresponds to 
brightness, horizontal axis to 
chroma)

IntensityInput display
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The Chroma Channel
The Chroma editor is useful tool for adjusting color saturation.

Chroma curve: Maps chroma in the original image (input) to the chroma of the image after editing (output).  Moving a point 
on the curve upward makes colors in the affected portion of the color range more vivid, while moving it downward makes 
the affected colors less vivid, or grayer.

Width slider: Adjust the width of the curve that passes through the selected point, increasing or decreasing the range of colors 
affected by the change.

Exclude Gray: Neutral colors (grays) may seem over saturated when chroma is raised.  Check this option to increase chroma 
without affecting grays.  This option has no effect when chroma is reduced below the value in the original image.

Output slider: Moving the slider affects the saturation of all colors in the image.

Intensity: The amount by which the saturation of the selected point will be increased or decreased in the output image.

Output slider

Width slider

IntensityInput display

Chroma curve

Exclude Gray checkbox

The Hue Channel

The hue editor is used to map selected colors in the original (input) image to a specifi c range of colors in the fi nal (output) image.  
This can be used, for example, to make all reds in the image slightly more orange, or even green or blue.

Hue curve: Maps hue in the original image (input) to the hue of the image after editing (output).  Select a point on the curve 
that corresponds to the desired input color and drag it up and down until it intersects with the desired output color.

Width slider: Adjust the width of the curve that passes through the selected point, increasing or decreasing the range of hues 
affected by the change.

Output slider: Moving the slider affects the hue of all colors in the image.

Scale button: Click to change the vertical scale from 60 ° through 120 ° to 180 ° and back again (the degrees in this scale 
refer to 360 ° color wheel).  Increasing the scale increases the range of hues visible in the display, while decreasing the scale 
increases precision.

Output slider

Scale button

Width slider

Input / output display

Hue curve
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Photo Effects
The Photo Effects palette is used to convert pictures to black-and-white, sepia, or another monochrome tint, or to adjust the 
brightness of the cyan / red, magenta / green, and yellow / blue channels.

1  Display the Photo Effects palette
Select the tool palette containing the Photo Effects palette from the View 
menu (the default location is Tool Palette 1) and click the triangle at the top 
left corner of the palette.

2  If the Apply button is off (  ) , turn it on (  )

3 Adjust settings
Effect: Choose Black and White to convert the image in the active window 
to black and white, Sepia to convert the image to sepia, or Tinted to con-
vert the image to another monochrome tint by dragging the balance sliders.  
Select None to use the balance sliders to adjust the brightness and contrast 
of the cyan / red, magenta / green, and yellow / blue channels in the original 
image.

Brightness / contrast slider: Drag the slider to the right to increase overall brightness and contrast, to the left to reduce bright-
ness and contrast, or enter a value between –100 and +100 directly in the text box to the right of the slider.

Enhance Dark Tones: Select this option to bring out details in shadows.

Auto: Click this button to optimize brightness and contrast without affecting color balance.  Enhance Dark Tones is auto-
matically selected.

Balance sliders: Use these sliders to adjust the brightness and contrast of the cyan / red, magenta / green, and yellow / blue 
channels, or enter a value between –100 and +100 directly in the text boxes to their right.  If the image has been converted 
to black-and-white or sepia, only the brightness of shades originally in the selected channels will be affected.  If Tinted is 
selected, the balance sliders control the choice of monochrome tint.

Apply button

Effect menu

Enhance Dark Tones

Balance sliders 

Settings button

Brightness / contrast 

Auto button

Magenta / green
Cyan / red

Yellow / blue

The Photo Effects Settings Menu
Clicking the triangle  in the top right corner of the Photo Effects palette dis-
plays the Photo Effects settings menu.

Option Description
Copy to Clip board Copy current Photo Effects settings to the clipboard.

Load…
Select this item to load settings previously saved using the Save… option (see be low).  A dialog will be displayed where you 
can navigate to the drive (volume) and di rec to ry con tain ing the desired settings fi le (only fi les with the extension “.npe” will 
be dis played).  The settings in the Photo Effects palette will in stant ly revert to the saved settings.

Save…
Select this item to save Photo Effects settings to a named fi le.  These settings can later be recalled using the Load… option.  
Choosing Save… displays a dialog where you can choose a destination and fi le name for current Photo Effects settings.  
Photo Effects settings are saved with the ex ten sion “.npe”.

Reset to Neutral Reset Photo Effects settings to default values.

Recent fi les
Recent Photo Effects settings fi les (up to four) are listed at the end of the settings menu.  Selecting a fi le from the list sets 
the controls in Photo Effects palette to the saved settings.

 The Set tings Menu

The Photo Effects Settings menu can also be displayed by selecting Photo Effects from the Set tings menu.
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Changes to the Noise Reduction Palette
The Noise Reduction palette now functions as follows:

Reducing Noise

1 Display the Noise Reduction palette
Select the tool palette containing the Noise Reduction palette from the View 
menu (the default location for the Noise Reduction palette is Tool Palette 2) 
and click the triangle at the top left corner of the palette.

2  If the Apply button is off (  ) , turn it on (  )

3  Adjust noise reduction options

Intensity: To reduce noise (a mottling phenomenon that occurs principally in photographs taken at high sensitivities), drag the 
slider to select a value from 0 (no noise reduction performed) to 100 (max i mum noise reduction).

Sharpness: High levels of noise reduction may result in loss of defi nition.  To increase sharpness, drag the slider to select a value 
from 0 (no sharpening performed) to 10 (max i mum sharpness).

Method: Choose Faster for faster processing, Better quality for increased precision.

Edge Noise Reduction: Check this box to re duce noise along edg es in the photo, making outlines more dis tinct.

Color Moiré Reduction (RAW images only): Color moiré (color interference caused by regular overlapping patterns) can be 
reduced using this option.  Choose the amount of compensation performed from Off, Low, Medium, or High.

4 View the results
Confi rm the effects of noise reduction on the entire image and adjust settings as necessary.

Apply button

Warning 
button

Settings menu
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D-Lighting
D-Lighting reveals details in shadows and highlights, correcting for underexposure in back-lit subjects or shaded areas of images 
and for overexposure in brightly lit areas.

1  Display the D-Lighting palette
Select the tool palette containing the D-Lighting palette from the View menu 
(the default location for the D-Lighting palette is Tool Palette 1) and click the 
triangle at the top left corner of the palette.

2 Turn the Apply button on ( )
Turn the Apply button on (  ) to enable D-Lighting.

3 Adjust settings

Method
Choose Faster (HS) for high-speed processing, Better Quality (HQ) for separate control of shadow and highlight adjust-
ment.

Faster (HS)
The following options are available when Faster (HS) is selected:

• Adjustment : Drag the slider to the right to enhance details in shadows and to reveal highlights where the subject is much 
brighter than the background or the background much brighter than the subject.  An adjustment value between 0 and 100 
can also be entered directly in the text box (the default setting is 25).

• Color Boost : Drag the slider to the right to increase color saturation, or enter a value between 0 and 100 directly in the text 
box to its right.

Better Quality (HQ)
Selecting Better Quality (HQ) displays the options shown at right.

• Shadow Adjustment : Drag the slider to the right to enhance details in shad-
ows, or enter a value between 1 and 100 directly in the text box to its right 
(the default setting is 50).

• Highlight Adjustment : Drag the slider to reveal highlights where the subject 
is much brighter than the background or the background much brighter than 
the subject.  An adjustment value between 1 and 100 can also be entered 
directly in the text box (the default setting is 1).

• Color Boost : Drag the slider to the right to increase color saturation, or enter a value between 0 and 100 directly in the text 
box to its right.

Apply button Settings menu

 Digital DEE

D-Lighting replaces the Digital DEE tool available in earlier versions of Nikon Capture 4.  Note that Digital DEE settings are ignored when joint 
settings fi les created with earlier versions of Nikon Capture 4 are loaded into Nikon Capture 4 version 4.2 or later, while Digital DEE settings saved 
with NEF images in earlier versions of Nikon Capture 4  are lost when these images are opened in Nikon Capture 4 version 4.2 or later.  Digital 
DEE settings fi les (extension “.ndd”) can not be loaded into Nikon Capture 4 version 4.2 or later.

 The Set tings Menu

The D-Lighting Settings menu can also be displayed by selecting D-Lighting from the Set tings menu.

The D-Lighting Settings Menu
Clicking the   button in the D-Lighting palette displays the D-Lighting Settings 
menu.

Option Description
Copy to Clip board Copy current D-Lighting settings to the clipboard.

Load…
Select this item to load D-Lighting settings pre vi ous ly saved using the Save… op tion (see be low).  A dialog will be displayed 
where you can navigate to the drive (vol ume) and di rec to ry con tain ing the desired settings fi le (only fi les with the extension 
“.ndl” will be dis played).  The set tings in the D-Lighting palette will instantly re vert to the saved settings.

Save…
Select this item to save D-Lighting settings to a named fi le.  These settings can later be re called using the Load… option.  
Choos ing Save… displays a dialog where you can choose a destination and fi le name for the current D-Lighting settings.  
D-Lighting set tings are saved with the ex ten sion “.ndl”.

Reset to Default Reset D-Lighting settings to default values.

Recent fi les
Recent D-Lighting settings fi les (up to four) are listed at the end of the settings menu.  Selecting a fi le from the list sets the 
controls in D-Lighting palette to the saved settings.
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Image Size
To view the fi nal size of the image in pixels, select Show Image Size from the Im-
age menu.  The Image Size dialog shows the size of the original (input) image in 
pixels; if the output size has been changed, the dialog will also list the fi nal (output) 
size of the image in pixels.
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The “Save As” Dialog
The following option has been added to the “Save As” dialog:

Embed ICC Profi le: Select this option to embed the specifi ed ICC profi le when the 
image is saved.  This option is automatically selected for images that have an ICC 
profi le and for photographs that are being saved without fi rst being edited.  It is 
not available with NEF fi les.

Saving Images in TIFF Format
LZW compression is now available when saving images in TIFF (RGB) format.  Selecting the compression option reduces fi le size 
without affecting image quality (amount of compression varies; note that in some cases, LZW compression may actually increase 
fi le size).
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Image Adjustments section
Auto Brightness: Select Always to apply auto brightness and contrast, or Only when related settings are neutral to adjust 
contrast and brightness only if they have not already been adjusted manually using Photo Effects, Tone Curves, or Color Bal-
ance.
Auto Color Boost: Select For People - Always or For Nature - Always to apply the effects of the Auto button in the Color 
Booster palette, or For people - only when related settings are neutral or For nature - only when related settings are 
neutral to apply this effect only if Color Booster settings have not already been adjusted manually.

Destination section
Embed ICC Profi le: Select this option to embed an ICC profi le in each image.

Save Progress section
Save Progress: Choose a name for the batch process displayed in the Save Progress window.

Batch
The following options have been added to the “Batch” dialog:

Maintain zoom when scale changes: Select this option to keep the same zoom ratio when changing output size in the Size/
Resolution palette.  The window is resized to display the image at the new output size.

…zoom increases to 33% to 
fi t image to window.

“Maintain zoom when scale 
changes” off

300-ppi image displayed at 
16% zoom.  If resolution is 

reduced to 150 ppi…

Original image

…zoom remains 16%; win-
dow is resized to fi t image.

“Maintain zoom when scale 
changes” on

The Preferences (“Options”) Dialog
The following option has been added to the Preferences (“Options”) dialog:
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Color Matching in Adobe Photoshop (Version 7.0 or Later)
From Nikon Capture 4.2, it is no longer necessary to manually match the Nikon Capture 4 monitor profi le with that used in Adobe 
Photoshop if a monitor profi le has already been selected in the operating system display property dialog.  For more in for ma tion, 
see “Choos ing a Monitor Profi le.”  

Download Options
The following option has been added to the “Download Options” dialog in Nikon Capture 4 Camera Control:

Embed ICC Profi le: Select this option to embed an ICC profi le in captured images.


